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1 HP Deskjet 2540 series Help

Learn how to use your HP Deskjet 2540 series

● Printer parts on page 4

● Control panel features on page 5

● Load media on page 24

● Copy documents on page 30

● Scan to a computer on page 32

● Print on page 11

● Replace ink cartridges on page 41

● Clear paper jam on page 62

● Check estimated ink levels on page 38
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2 Get to know the HP Deskjet 2540 series

● Printer parts

● Control panel features

● Wireless settings

● Status lights

● Auto-Off
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Printer parts

1 Input tray

2 Input tray guard

3 Cartridges

4 Lid

5 Lid-backing

6 Paper-width guide for the input tray

7 Control panel

8 Cartridge access door

9 Output tray

10 Output tray extender (also referred to as the tray extender)

11 Scanner glass

12 Rear USB port

13 Power connection.
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Control panel features

Feature Description

1 On button: Turns the printer on or off. When the printer is off, a minimal amount of power is
still used. To completely remove power, turn off the printer, then unplug the power cord.

2 Cancel button: Stops the current operation.

3 Wireless status light and button: Blue light indicates a wireless connection. Press the button
to turn on or off the printer wireless capabilities. Press and hold the button for more than 3
seconds until light blinks to start Wi-Fi Protected Setup (WPS) push button mode.

4 Wireless Direct status light and button: White light indicates the status of HP wireless direct.
Press the button to turn on or off HP wireless direct.

5 Start Copy Black button: Starts a black-and-white copy job. Acts as a resume button after
resolving print problems.

6 Start Copy Color button: Starts a color copy job. Acts as a resume button after resolving print
problems.

7 Attention light: Indicates that there is a paper jam, the printer is out of paper, or some event
that requires your attention.

8 Cartridge lights: Indicates low ink or ink cartridge problems.

9 Control panel display: Indicates the number of copies, media error, and wireless status.
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Wireless settings
Press the Wireless button to turn on the printer wireless capabilities.

● If the printer has an active connection to a wireless network, the wireless light will be on solid
blue. In the mean time, the printer display will show the wireless icon and signal bar.

● If wireless is turned off, the wireless light will be off.

● If wireless is enabled (wireless radio on) and you do not have a wireless connection, the wireless
light will be blinking. In the mean time, the display screen shows the wireless strength indicator.

How do I? Instructions

Print network configuration page.

The network configuration page will display the network
status, hostname, network name, and more.

Press the Wireless button and the Start Copy Black button
from the printer control panel at the same time.

Print wireless network test report.

The wireless network test report will display the diagnostics
results for the status of the wireless network, wireless signal
strength, detected networks, and more.

Press the Wireless button and the Start Copy Black button
from the printer control panel at the same time.

Restore network settings to default settings. Press the Wireless button and the Cancel button from the
printer control panel at the same time, and then hold them for
5 seconds.

Turn wireless on or off. Press the Wireless button from the printer control panel.

Establish a WPS connection. Wi-Fi Protected Setup (WPS – requires WPS router)
on page 48
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Status lights
When the printert is turned on, the On button light will be lit. When the printer is processing a job, the
On button light will be blinking. Additional blinking lights signal errors that you can resolve. See below
to learn about blinking lights and what to do.

Light behavior Cause and Solution

Attention light is blinking. ● Output tray closed when printing is attempted.

Open the output tray.

● Scanner is not working.

Turn off and turn on the printer.

If the problem persists, contact HP. The printer still prints
even if the scanner is not working.

Attention light and both cartridge lights are blinking. ● Cartridge access door is open.

Close the cartridge access door. For more information,
see Prepare trays on page 70.

● Cartridge access door is open and one or more ink
cartridges are in error state.

Remove and reinsert the ink cartridges and then close
the cartridge access door.

● Cartridge carriage inside the printer has stalled.

Open the cartridge access door and make sure the
carriage is not obstructed. Move the carriage to the
right, close the cartridge access door, and then press
any button, except Cancel, to resume. See Clear print
carriage on page 68 for more information.

Both cartridge lights are blinking. Both cartridges are missing, do not have the tape removed,
may be very low on ink, or defective.

● Install missing cartridges, remove the pink tape from the
cartridges, or replace the defective cartridges. For more
information, see Replace ink cartridges on page 41.

● If the print quality is poor, consider replacing the ink
cartridge. For more information, see Replace ink
cartridges on page 41.

● Determine if ink cartridges are defective. For more
information, see Identify a defective cartridge
on page 69.
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Light behavior Cause and Solution

One cartridge light is blinking. Blinking cartridge light indicates that corresponding cartridge
has a problem. Cartridge may be improperly installed,
incompatible, or very low on ink.

● If you see a message on your computer screen, refer to
the message for more information about the problem.

● If there is no message on your computer screen, try
removing and reinserting the ink cartridge.

● Confirm that you are using the correct HP ink cartridge
for your printer.

● If the print quality is poor, consider replacing the ink
cartridge. For more information, see Replace ink
cartridges on page 41.

The media error indicator and Attention light are blinking. ● There is no paper, or paper is not feeding.

Load paper, then press any button, except Cancel, to
resume printing. For more information, see Load media
on page 24.

● There is a paper jam.

Clear a paper jam. Load paper, then press any button,
except Cancel, to resume printing. For more information
about how to clear a paper jam, see Clear paper jam
on page 62.

Both cartridge lights are solid on. Both cartridges are low on ink and will need to be replaced
soon.

● Continue to print using the remaining ink cartridges.
Also, the quality of printed documents might be
affected.

● If the print quality is poor, consider replacing the ink
cartridges. For more information, see Replace ink
cartridges on page 41.

One cartridge light is solid on. ● One corresponding cartridge is low on ink and will need
to be replaced soon.

◦ Continue to print using the remaining ink cartridge.
Also, the quality of printed documents might be
affected.

◦ If the print quality is poor, consider replacing the
ink cartridge. For more information, see Replace
ink cartridges on page 41.

● One corresponding cartridge still has the tape on, is
missing, or is counterfeit.

◦ Install the ink cartridge, or remove the pink tape
from the ink cartridge, or replace the defective ink
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Light behavior Cause and Solution

cartridge. For more information, see Replace ink
cartridges on page 41.

◦ Determine if the ink cartridge is defective. For
more information, see Identify a defective cartridge
on page 69.

◦ If the ink cartridge is counterfeit, replace the
corresponding ink cartridge with an original HP ink
cartridge, or press any button, except the Cancel
button, to resume printing.

On button light, Wireless status light, Wireless Direct status
light, letter “E”, the media error indicator, the wireless
strength indicator, Attention light, and both cartridge lights
are blinking.

The printer is in an error state.

To exist the error state, reset the printer.

1. Turn printer off.

2. Unplug the power cord.

3. Wait a minute, plug power cord back in.

4. Turn on the printer.

If the problem persists, contact HP.

Wireless status light is blinking and the signal bar is cycling. ● The printer is establishing a wireless network
connection.

● WPS is in progress.

Wireless status light is blinking and the wireless strength
indicator is solid on.

There is no wireless signal.

● Make sure your wireless router or access point is
powered on.

● Move the printer closer to the wireless router.

Wireless status light and the wireless strength indicator are
blinking.

The printer has a problem establishing the wireless network,
an error occurs or overlap session is detected when using
WPS.

Turn off wireless by pressing the Wireless button to clear the
error.
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Auto-Off
Auto-Off is automatically enabled by default when you turn on the printer. When Auto-Off is enabled,
the printer will automatically turn off after 2 hours of inactivity to help reduce energy use. Auto-Off
turns the printer off completely, so you must use the On button to turn the printer back on. For printer
models with wireless or Ethernet network capability, Auto-Off is automatically disabled when the
printer establishes a wireless or Ethernet network connection. Even when Auto-Off is disabled, the
printer enters Sleep mode after 5 minutes of inactivity to help reduce energy use.

You can change the Auto-Off setting from the printer software.

To change Auto-Off setting

1. Depending on your operating system, do one of the following to open the printer software:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on
the app bar, and then click the icon with the printer's name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series, and then click HP Deskjet
2540 series.

2. In the printer software, select Print & scan, and then select Maintain Your Printer to access the
printer toolbox.

3. In the printer toolbox, click Advanced Settings, and then follow the on-screen instructions.

Once you change the setting, the printer maintains the setting that you choose.
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3 Print

This section contains the following topics:

● Print documents

● Print photos

● Print envelopes

● Print with HP wireless direct

● Print using the maximum dpi

● Tips for print success
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Print documents
Load paper

1. Make sure the output tray is open.

2. Make sure you have paper loaded in the input tray.

To print a document

1. From your software, click the Print button.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab of the print driver, select the appropriate paper type and print
quality from the Media drop-down list.

● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

5. Click OK to close the Properties dialog box.

6. Click Print or OK to begin printing.

To print on both sides of the page

1. From your software, click the Print button.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

4. Select the appropriate options.
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● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type and print quality from the Media
drop-down list.

● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

5. On the Layout tab, select an appropriate option from the Print on Both Sides Manually drop-
down list.

6. Click OK to print.

7. After the even numbered pages of the document have been printed, remove the document from
the output tray.

8. Follow the on-screen instructions, reload the paper in the input tray with the blank side up and
top of page down, and then click Continue.
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Print photos
Load photo paper

1. Make sure the output tray is open.

2. Remove all paper from the input tray, and then load the photo paper with side to be printed on
facing up.

To print a photo on photo paper

1. On the File menu in your software, click Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab of the print driver, select the appropriate paper type and print
quality from the Media drop-down list.

● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

NOTE: For maximum dpi resolution, go to the Paper/Quality tab and select Photo Paper, Best
Quality from the Media drop-down list. Then go to the Advanced tab and select Yes from the
Print in Max DPI drop-down list. If you want to print Max DPI in grayscale, select High Quality
Grayscale from the Print in Grayscale drop-down list.

5. Click OK to return to the Properties dialog box.

6. Click OK, and then click Print or OK in the Print dialog box.

NOTE: After the printing is finished, remove unused photo paper from the input tray. Store the photo
paper so it does not start to curl, which could reduce the quality of your printout.
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Print envelopes
You can load one or more envelopes into the input tray of the HP Deskjet 2540 series. Do not use
shiny or embossed envelopes or envelopes that have clasps or windows.

NOTE: For specific details on how to format text for printing on envelopes, consult the help files in
your word application.

Load envelopes

1. Make sure the output tray is open.

2. Slide the paper-width guide all the way to the left.

3. Place the envelopes in the right side of the tray. The side to be printed on should face up.

4. Push the envelopes into the printer until they stop.

5. Slide the paper-width guide firmly against the edge of the envelopes.

To print an envelope

1. On the File menu in your software, click Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab of the print driver, select the appropriate paper type and print
quality from the Media drop-down list.

● Click Advanced to select the appropriate paper size from the Paper Size drop-down list.

5. Click OK, and then click Print or OK in the Print dialog box.
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Print with HP wireless direct
With HP wireless direct, you can print wirelessly from a computer, smart phone, tablet, or other
wireless-capable device—without connecting to an existing wireless network.

When using HP wireless direct, note the following guidelines:

● Make sure your computer or mobile device has the necessary software:

If you are using a computer, make sure you have installed the printer software provided with the
printer.

● If you are using a mobile device, make sure you have installed a compatible printing app. For
more information about mobile printing, visit www.hp.com/global/us/en/eprint/
mobile_printing_apps.html.

● Make sure HP wireless direct is turned on in the printer and, if necessary, security is enabled.
For more information, see Connect wirelessly to the printer without a router on page 53.

● Up to five computers and mobile devices can use the same HP wireless direct connection.

● HP wireless direct can be used while the printer is also connected to a computer using USB
cable or to a network using a wireless connection.

● HP wireless direct cannot be used to connect a computer, mobile device, or printer to the
Internet.

 Click here to go online for more information.

NOTE: At this time, these websites might not be available in all languages.

This section contains the following topics:

● Print from a wireless-capable mobile device

● Print from a wireless-capable computer

Print from a wireless-capable mobile device
Make sure you have installed a compatible printing app on your mobile device. For more information,
visit www.hp.com/global/us/en/eprint/mobile_printing_apps.html.

1. Make sure you have turned on HP wireless direct on the printer. For more information, see
Connect wirelessly to the printer without a router on page 53.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the
documentation provided with the mobile device.

NOTE: If your mobile device does not support Wi-Fi, you are not able to use HP wireless
direct.

3. From the mobile device, connect to a new network. Use the process you normally use to
connect to a new wireless network or hotspot. Choose the HP wireless direct name from the list
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of wireless networks shown such as HP-Print-**-Deskjet 2540 series (where ** are the unique
characters to identify your printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Print your document.

Print from a wireless-capable computer
1. Make sure you have turned on HP wireless direct on the printer. For more information, see

Connect wirelessly to the printer without a router on page 53 for more information.

2. Turn on the computer's Wi-Fi connection. For more information, see the documentation provided
with the computer.

NOTE: If your computer does not support Wi-Fi, you are not able to use HP wireless direct.

3. From the computer, connect to a new network. Use the process you normally use to connect to
a new wireless network or hotspot. Choose the HP wireless direct name from the list of wireless
networks shown such as HP-Print-**-Deskjet 2540 series (where ** are the unique characters to
identify your printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless
network. If the printer has been installed and connected to your computer with a USB cable,
follow the steps below to install the printer software using the HP wireless direct connection.

a. Depending on your operating system, do one of the following:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps
on the app bar, and then click Printer Setup & Software.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP DESKJET 2540 series, and then click Printer
Setup & Software.

b. Select Connect New Printer.

c. When the Connection Options software screen appears, select Wireless.

Select HP DESKJET 2540 series from the list of detected printers.

d. Follow the on-screen instructions.

5. Print your document.
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Print using the maximum dpi
Use maximum dots per inch (dpi) to print high-quality, sharp images on the photo paper.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of
disk space.

To print in Maximum dpi mode

1. On the File menu in your software, click Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer Properties, Printer, or Preferences.

4. Click the Paper/Quality tab.

5. From the Media drop-down list, must select Photo Paper, Best Quality to enable printing in
maximum dpi.

6. Click the Advanced button.

7. In the Printer Features area, select Yes from the Print in Max DPI drop-down list.

8. Select the appropriate paper size from the Paper Size drop-down list.

9. Click OK to close the advanced options.

10. Confirm Orientation on the Layout tab, and then click OK to print.
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Tips for print success
To print successfully, the HP ink cartridges should be functioning properly with sufficient ink, the
paper should be loaded correctly, and the print should have the appropriate settings. Print settings do
not apply to copying or scanning.

Ink tips

● Use original HP ink cartridges.

● Install both the black and tri-color cartridges correctly.

For more information, see Replace ink cartridges on page 41.

● Check the estimated ink levels in the ink cartridges to make sure there is sufficient ink.

For more information, see Check estimated ink levels on page 38.

● If the print quality is not acceptable, see Improve print quality on page 58 for more information.

Paper loading tips

● Load a stack of paper (not just one page). All of the paper in the stack should be the same size
and type to avoid a paper jam.

● Load the paper with side to be printed on facing up.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the
paper-width guide does not bend the paper in the input tray.

For more information, see Load media on page 24.

Printer settings tips

● On the Paper/Quality tab of the print driver, select the appropriate paper type and print quality
from the Media drop-down list.

● Select the appropriate paper size from the Paper Size drop-down list in the Advanced Options
dialog box. Access the Advanced Options dialog box by clicking the Advanced button on the
Layout or Paper/Quality tab.

● To change default print settings, click Print & Scan, and then click Set Preferences in the printer
software.

Depending on your operating system, do one of the following to open the printer software:

◦ Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on
the app bar, and then click the icon with the printer's name.

◦ Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series, and then click HP Deskjet
2540 series.

● If you want to print a black and white document using black ink only, click the Advanced button.
From the Print in Grayscale drop-down menu, select Black Ink Only, then click the OK button.
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Notes

● Original HP ink cartridges are designed and tested with HP printers and papers to help you
easily produce great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or
repairs required as a result of using a non-HP supply will not be covered under warranty.

If you believe the purchased original HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

● Ink level warnings and indicators provide estimates for planning purposes only.

NOTE: When you receive a low-ink warning message, consider having a replacement ink
cartridge available to avoid possible printing delays. You do not need to replace the ink
cartridges until the print quality becomes unacceptable.

● You can print your document on both sides of the paper.
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4 Paper basics

You can load many different types and sizes of paper in the HP Printer, including letter or A4 paper,
photo paper, transparencies, and envelopes.

This section contains the following topics:

● Recommended papers for printing

● Load media
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Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically designed for
the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

ColorLok

● HP recommends plain papers with the ColorLok logo for printing and copying of everyday
documents. All papers with the ColorLok logo are independently tested to meet high standards
of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, and
dry faster than ordinary plain papers. Look for papers with the ColorLok logo in a variety of
weights and sizes from major paper manufacturers.

Photo printing

● HP Premium Plus Photo Paper

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With
HP Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can
share them right off the printer. It is available in several sizes, including A4, 8.5 x 11 inch, 4 x 6
inch (10 x 15 cm), 5 x 7 inch (13 x 18 cm), and 11 x 17 inch (A3), and in two finishes - glossy or
soft gloss (semi-gloss). Ideal for framing, displaying, or gifting your best photos and special
photo projects. HP Premium Plus Photo Paper delivers exceptional results with professional
quality and durability.

● HP Advanced Photo Paper

This thick photo paper features an instant-dry finish for easy handling without smudging. It
resists water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to
a store-processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm
(4 x 6 inch), 13 x 18 cm (5 x 7 inch). It is acid-free for longer lasting documents.

● HP Everyday Photo Paper

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing.
This affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you
use this paper with any inkjet printer. It is available in glossy finish in several sizes, including A4,
8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch). For longer-lasting photos, it is acid-free.

Business documents

● HP Premium Presentation Paper or HP Professional Paper 120

These papers are heavy two-sided matte papers perfect for presentation, proposals, reports,
and newsletters. They are heavyweight for an impressive look and feel.

● HP Brochure Paper or HP Professional Paper 180
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These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the
perfect choice for near-photographic reproductions and business graphics for report covers,
special presentations, brochures, mailers, and calendars.

Everyday printing

● HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough
for two-sided color usage with no show-through, which makes it ideal for newsletters, reports,
and flyers. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.

● HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel
more substantial than documents printed on standard multipurpose or copy paper. It features
ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer
lasting documents.

● HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and
other everyday documents. It features ColorLok Technology for less smearing, bolder blacks,
and vivid colors. It is acid-free for longer lasting documents.

● HP Office Recycled Paper

HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber. It
features ColorLok Technology for less smearing, bolder blacks and vivid colors.

Special projects

● HP Iron-On Transfers

HP Iron-on Transfers (for light or white fabrics) are the ideal solution for creating custom T-shirts
from your digital photos.
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Load media
Select a paper size to continue.

Load full-size paper

1. Raise the input tray.

2. Lower the output tray and pull out the output tray extender.

3. Slide the paper-width guide to the left.

4. Insert a stack of paper into the input tray with the short edge forward and the print side up, and
slide the stack of paper down until it stops.
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5. Slide the paper-width guide to the right until it stops at the edge of paper.

Load small-size paper

1. Raise the input tray.

2. Lower the output tray and pull out the output tray extender.

3. Slide the paper-width guide to the left.
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4. Insert a stack of photo paper with the short edge down and the print side up, and slide the stack
of paper forward until it stops.

5. Slide the paper-width guide to the right until it stops at the edge of paper.

Load envelopes

1. Raise the input tray.

2. Lower the output tray and pull out the output tray extender.

3. Slide the paper-width guide to the left and remove all paper from the input tray
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4. Insert one or more envelopes into far-right side of the input tray and slide the stack of envelopes
down until it stops.

The side to be printed on should face up. The flap should be on the left side and facing down.

5. Slide the paper-width guide to the right against the stack of envelopes until it stops.
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5 Copy and scan

● Copy documents

● Scan to a computer

● Tips for copy success

● Tips for scan success

ENWW 29



Copy documents
NOTE: All documents are copied in normal quality print mode. You cannot change the print mode
quality when copying.

1-sided original to 1-sided copy

1. Load either small photo paper or full-size paper in the input tray.

2. Load original.

a. Lift the lid of the printer.

b. Load original print side down on the right front corner of the scanner glass.
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c. Close the lid.

3. Start copy.

▲ Press either Start Copy Black or Start Copy Color. Increase the number of copies by
pressing the button multiple times.
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Scan to a computer
NOTE: To scan to a computer, the HP Deskjet 2540 series and computer must be connected and
turned on.

Single page scan

1. Load original.

a. Lift the lid of the printer.

b. Load original print side down on the right front corner of the scanner glass.

c. Close the lid.

2. Start scan.

a. Start the scan job using the printer software. Depending on your operating system, do one
of the following to open the printer software:
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● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps
on the app bar, and then click the icon with the printer's name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series, and then click HP Deskjet
2540 series.

b. In the printer software, select the Print & Scan tab, and then select Scan a Document or
Photo under Scan. You will see scan options that you can select on-screen.
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Tips for copy success
● Load your original print side down on the right front corner of the scanner glass.

● To resize the copy, scan the original to the computer, resize it using an application on the
computer, and then print the resized document.

● Clean the scanner glass and make sure that there are no foreign materials adhering to it.

 Click here to go online for more information.
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Tips for scan success
● Load your original print side down on the right front corner of the scanner glass.

● Clean the scanner glass and make sure that there are no foreign materials adhering to it.

 Click here to go online for more information.
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6 Work with ink cartridges

This section contains the following topics:

● Check estimated ink levels

● Order ink supplies

● Choose right ink cartridges

● Replace ink cartridges

● Use single-cartridge mode

● Cartridge warranty information

● Tips for working with cartridges
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Check estimated ink levels
You can easily check the ink supply level to determine how soon you might need to replace an ink
cartridge. The ink supply level shows an estimate of the amount of ink remaining in the ink cartridges.

To check the ink levels

1. Depending on your operating system, do one of the following to open the printer software:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on
the app bar, and then click the icon with the printer's name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series, and then click HP Deskjet
2540 series.

2. In the printer software, click Estimated Ink Levels.

NOTE: If you have installed a refilled or remanufactured ink cartridge, or an ink cartridge that has
been used in another printer, the ink level indicator might be inaccurate or unavailable.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you
receive a low-ink warning message, consider having a replacement ink cartridge available to avoid
possible printing delays. You do not have to replace the ink cartridges until the print quality is
unacceptable.

NOTE: Ink from the ink cartridges is used in the printing process in a number of different ways,
including in the initialization process, which prepares the printer and cartridges for printing, and in
printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some
residual ink is left in the ink cartridge after it is used. For more information, see www.hp.com/go/
inkusage.
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Order ink supplies
Before ordering cartridges, locate the correct cartridge number.

Locate the cartridge number on the printer

● The cartridge number is located inside the cartridge access door.

Locate the cartridge number in the printer software

1. Depending on your operating system, do one of the following to open the printer software:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on
the app bar, and then click the icon with the printer's name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series, and then click HP Deskjet
2540 series.

2. In the printer software, click Shop, and then click Shop For Supplies Online.

The correct cartridge number appears when you use this link.

To order original HP supplies for the HP Deskjet 2540 series, go to www.hp.com/buy/supplies. If
prompted, choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.

NOTE: Ordering ink cartridges online is not supported in all countries/regions. If it is not available in
your country/region, you may still view supplies information and print a list for reference when
shopping at a local HP reseller.
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Choose right ink cartridges
HP recommends that you use original HP cartridges. Original HP cartridges are designed and tested
with HP printers to help you easily produce great results, time after time.

40 Chapter 6   Work with ink cartridges ENWW



Replace ink cartridges
To replace the ink cartridges

1. Check that power is on.

2. Load paper.

3. Remove the ink cartridge.

a. Open the cartridge access door and wait for the print carriage to move to the center of the
printer.

b. Press down to release the ink cartridge, then remove it from the slot.

4. Insert one new ink cartridge.

a. Remove the ink cartridge from the packaging.
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b. Remove the plastic tape using the pink pull tab.

c. Slide the ink cartridge into slot until it clicks into place.

d. Close the cartridge access door.

NOTE: The HP printer software prompts you to align the ink cartridges when you print a
document after installing the new ink cartridge.
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Use single-cartridge mode
Use the single-cartridge mode to operate the HP Deskjet 2540 series with only one ink cartridge. The
single-cartridge mode is initiated when an ink cartridge is removed from the ink cartridge carriage.
During single-cartridge mode, the printer can copy documents, copy photos, and print jobs from the
computer.

NOTE: When the HP Deskjet 2540 series operates in single-cartridge mode, a message is
displayed on screen. If the message is displayed and two ink cartridges are installed in the printer,
verify that the protective piece of plastic tape has been removed from each ink cartridge. When the
plastic tape covers the ink cartridge contacts, the printer cannot detect that the ink cartridge is
installed.

Exit single-cartridge mode

● Install both the black and tri-color ink cartridges in the HP Deskjet 2540 series to exit single-
cartridge mode.
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Cartridge warranty information
The HP cartridge warranty is applicable when the cartridge is used in its designated HP printing
device. This warranty does not cover HP ink cartridges that have been refilled, remanufactured,
refurbished, misused, or tampered with.

During the warranty period, the cartridge is covered as long as the HP ink is not depleted and the end
of warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be
found on the cartridge as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the
printer.
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Tips for working with cartridges
Use the following tips to work with cartridges:

● To protect the cartridges from drying out, always turn the printer off using the On button, and
wait until the On button light goes out.

● Do not open or untape cartridges until you are ready to install them. Leaving tape on the
cartridges reduces ink evaporation.

● Insert the cartridges into the correct slots. Match the color and icon of each cartridge to the color
and icon for each slot. Make sure the cartridges snap into place.

● Align the printer for best print quality. See Improve print quality on page 58 for more
information.

● When the Estimated Ink Levels screen shows one or both cartridges in a low state, consider
getting replacement cartridges to avoid possible printing delays. You do not need to replace the
cartridges until print quality becomes unacceptable. See Replace ink cartridges on page 41 for
more information.

● If you remove a cartridge from the printer for any reason, try to replace it again as soon as
possible. Outside of the printer, if unprotected, cartridges begin to dry out.
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7 Connectivity

● Wi-Fi Protected Setup (WPS – requires WPS router)

● Traditional wireless connection (requires router)

● USB connection (non-network connection)

● Change from a USB connection to a wireless network

● Connect wirelessly to the printer without a router

● Tips for setting up and using a networked printer

● Advanced printer management tools (for networked printers)

ENWW 47



Wi-Fi Protected Setup (WPS – requires WPS router)
These instructions are for customers who have already set up and installed the printer software. For
the first time installation refer to the setup instructions that came with the printer.

To connect the HP Deskjet 2540 series to a wireless network using WPS, you will need the following:

● A wireless 802.11b/g/n network that includes a WPS-enabled wireless router or access point.

NOTE: The HP Deskjet 2540 series only supports connections using 2.4GHz.

● A desktop computer or laptop is with either wireless networking support, or a network interface
card (NIC). The computer must be connected to the wireless network that you intend to install
the HP Deskjet 2540 series on.

NOTE: If you have a WPS router with a WPS push button, follow the Push Button method. If you
are not certain your router has a push button, follow the Wireless Settings Menu method.

Push Button Configuration (PBC) method

1. Press and hold the Wireless button on the printer for more than 3 seconds to start WPS push
mode. The Wireless status light starts blinking.

2. Press the WPS button on your router.

NOTE: The product begins a timer for approximately two minutes while a wireless connection is
established.

PIN method

1. Press the Wireless button and Start Copy Black button at the same time to print the network
configuration page, and then locate a WPS PIN.

The WPS PIN is printed at the top of the printed information page.

2. Press and hold the Wireless button from the printer control panel for more than 3 seconds. The
Wireless status light starts blinking.

3. Open the configuration utility or software for the wireless router or wireless access point, and
then enter the WPS PIN.

NOTE: For more information about using the configuration utility, see the documentation
provided with the router or wireless access point.

Wait for about 2 minutes. If the printer connects successfully, the wireless light stops blinking but
remains lit.
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Traditional wireless connection (requires router)
To connect the HP Deskjet 2540 series to an integrated wireless WLAN 802.11 network, you will
need the following:

● A wireless 802.11b/g/n network that includes a wireless router or access point.

NOTE: The HP Deskjet 2540 series only supports connections using 2.4GHz.

● A desktop computer or laptop with either wireless networking support, or a network interface
card (NIC). The computer must be connected to the wireless network that you intend to install
the HP Deskjet 2540 series on.

● Network name (SSID).

● WEP key or WPA Passphrase (if needed).

To connect the printer

1. Insert the printer software CD in the computer CD-ROM drive.

NOTE: Do not connect the USB cable to the printer until you are prompted to do so.

2. Follow the on-screen instructions.

When you are prompted, connect the product to the computer by selecting Wireless in the
Connection Options screen. Follow the on-screen prompts to enter your wireless network
settings. The printer will attempt to connect to the network. If the connection fails, follow the
prompts to correct the problem, and then try again.

3. When the setup is finished, you will be prompted to disconnect the USB cable and test the
wireless network connection. Once the printer connects successfully to the network, you will not
need USB cable when installing the printer on the subsequent computers. Instead, the printer
name will appear in the network list and you can select it directly.

Connect a new printer

If you have not connected the printer to your computer, or you want to connect another new printer of
the same model to your computer, you can use the Connect a new printer function to set up the
connection.

NOTE: Use this method if you have already installed the printer software.

1. Depending on your operating system, do one of the following:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on
the app bar.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series.

2. Click Printer Setup & Software.

3. Select Connect a new printer. Follow the on-screen instructions.
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Change network settings

This method is available if you have already installed the printer software.

NOTE: This method requires a USB cable. Do not connect the USB cable until prompted to do so.

1. Depending on your operating system, do one of the following:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on
the app bar.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series.

2. Click Printer Setup & Software.

3. Select Reconfigure Wireless Settings. Follow the on-screen instructions.
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USB connection (non-network connection)
The HP Deskjet 2540 series supports a rear USB 2.0 High Speed port for connection to a computer.

To connect the printer with the USB cable

1. Insert the printer software CD in the computer CD-ROM drive.

NOTE: Do not connect the USB cable to the printer until you are prompted to do so.

2. Follow the on-screen instructions. When you are prompted, connect the printer to the computer
by selecting USB on the Connection Options screen.

3. Follow the on-screen instructions.

If the printer software has been installed, the printer will operate as a plug-and-play device. If the
software has not been installed, insert the CD that came with the printer and follow the on-screen
instructions.
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Change from a USB connection to a wireless network
If you first set up your printer and installed the software with a USB cable, directly connecting the
printer to your computer, you can easily change to a wireless network connection. You will need a
wireless 802.11b/g/n network that includes a wireless router or access point.

NOTE: The HP Deskjet 2540 series only supports connections using 2.4GHz.

Before changing from a USB connection to a wireless network, make sure that:

● The printer is connected to your computer with the USB cable until you are prompted to
disconnect the cable.

● The computer is connected to the wireless network that you intend to install the printer on.

Change from a USB connection to a wireless network

1. Depending on your operating system, do one of the following:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on
the app bar.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series.

2. Click Printer Setup & Software.

3. Select Convert a USB connected printer to wireless. Follow the on-screen instructions.
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Connect wirelessly to the printer without a router
HP wireless direct allows your wireless devices such as computers, smart phones, tablet, and other
wireless, to connect to your printer directly through the wireless network, using the process you
currently use to connect your wireless device to new wireless networks and hotspots. With HP
wireless direct, you can print directly to the printer wirelessly, without a wireless router, from your
wireless enabled devices.

To connect wirelessly to the printer without a router, press the Wireless Direct button from the printer
control panel. If this is the first time you turn on HP wireless direct, a How to Connect information
page will be printed out. Follow the instructures on the printed information page.

NOTE: HP wireless direct with security is enabled by default when you turn it on. The HP wireless
direct password can be found by printing the information page.

NOTE: The information page may not be available in all languages. It only can be printed
automatically when you first enable HP wireless direct.

To print the information page, press and hold the Wireless Direct button for more than 3 seconds.

If HP wireless direct is turned on, the Wireless Direct status light is solid on.
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Tips for setting up and using a networked printer
Use the following tips to set up and use a networked printer:

● When setting up the wireless networked printer, make sure your wireless router or access point
is powered on. The printer searches for wireless routers, then lists the detected network names
on the computer.

● If your computer is connected to a Virtual Private Network (VPN), you need to disconnect from
the VPN before you can access any other device on your network, including the printer.

● Learn how to find your network security settings. Click here to go online for more information.

● Learn about other troubleshooting tips. Click here to go online for more information.

● Learn about the HP Print and Scan Doctor. Click here to go online for more information.

● Learn how to change from a USB to wireless connection. Click here to go online for more
information.

● Learn how to work with your firewall and antivirus programs during printer setup. Click here to go
online for more information.
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Advanced printer management tools (for networked printers)
When the printer is connected to a network, you can use the EWS to view status information, change
settings, and manage the printer from your computer.

NOTE: To view or change some settings, you might need a password.

You can open and use the EWS without being connected to the Internet. However, some features are
not available.

● To open the embedded web server

● About cookies

To open the embedded web server
You can access the EWS through either the network, the printer software, or HP wireless direct.

Open the embedded web server through network

NOTE: The printer must be on a network and must have an IP address. The IP address for the
printer can be found by printing a network configuration page.

● In a supported Web browser on your computer, type the IP address or hostname that has been
assigned to the printer.

For example, if the IP address is 192.168.0.12, type the following address into a Web browser:
http://192.168.0.12.

Open the embedded web server from printer software

1. Depending on your operating system, do one of the following to open the printer software:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on
the app bar, and then click the icon with the printer's name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series, and then click HP Deskjet
2540 series.

2. Click Print & Scan, and then click Printer Home Page (EWS).

Open the embedded web server through HP wireless direct

1. From the printer control panel, press the Wireless Direct button to turn on HP wireless direct. For
more information, see Connect wirelessly to the printer without a router on page 53.

2. From your wireless computer, turn wireless on, search for and connect to the HP wireless direct
name, for example: HP-Print-**-Deskjet 2540 series. If you have HP wireless direct security on,
enter the HP wireless direct password when prompted.

3. In a supported Web browser on your computer, type the following address: http://192.168.223.1.

About cookies
The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you
are browsing. These files let the EWS recognize your computer the next time you visit. For example,
if you have configured the EWS language, a cookie helps remember which language you have
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selected so that the next time you access the EWS, the pages are displayed in that language.
Though some cookies are cleared at the end of each session (such as the cookie that stores the
selected language), others (such as the cookie that stores customer-specific preferences) are stored
on the computer until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a
cookie is offered, which allows you to decide which cookies to accept or refuse. You can also use
your browser to remove unwanted cookies.

NOTE: Depending on your printer, if you disable cookies, you also disable one or more of the
following features:

● Starting where you left the application (especially useful when using setup wizards)

● Remembering the EWS browser language setting

● Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete
cookies, see the documentation available with your Web browser.
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8 Solve a problem

This section contains the following topics:

● Improve print quality

● Clear paper jam

● Unable to print

● Clear print carriage

● Identify a defective cartridge

● Prepare trays

● Resolve copy and scan issues

● Printer failure

● Ink cartridge problem

● Older generation cartridges

● Networking

● HP support
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Improve print quality
NOTE: To protect the cartridges from drying out, always turn the printer off using the On button, and
wait until the On button light goes out.

To improve print quality

1. Make sure you are using original HP ink cartridges.

2. Check the printer software to make sure you have selected the appropriate paper type and print
quality from the Media drop-down list.

In the printer software, click Print & Scan and then click Set Preferences to access the print
properties.

3. Check the estimated ink levels to determine if the ink cartridges are low on ink.

For more information, see Check estimated ink levels on page 38. If the ink cartridges are low on
ink consider replacing them.

4. Align the ink cartridges.

To align the ink cartridges

a. Load letter or A4 unused plain white paper into the input tray.

b. Depending on your operating system, do one of the following to open the printer software:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps
on the app bar, and then click the icon with the printer's name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series, and then click HP Deskjet
2540 series.

c. In the printer software, click Print & Scan and then click Maintain Your Printer to access the
printer toolbox.

The printer toolbox appears.

d. Click Align Ink Cartridges on the Device Services tab.

The printer prints an alignment sheet.
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e. Load the cartridge alignment sheet print side down on the right front corner of the scanner
glass.

f. Press the Start Copy Black button. The printer aligns the ink cartridges. Recycle or discard
the cartridge alignment sheet.

5. Print a diagnostics page if the ink cartridges are not low on ink.

To print a diagnostics page

a. Load letter or A4 unused plain white paper into the input tray.

b. Depending on your operating system, do one of the following to open the printer software:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps
on the app bar, and then click the icon with the printer's name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series, and then click HP Deskjet
2540 series.

c. In the printer software, click Print & Scan and then click Maintain Your Printer to access the
printer toolbox.

d. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page.
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e. Review the blue, magenta, yellow, and black boxes on the diagnostics page.

6. Clean the ink cartridges automatically, if the diagnostic page shows steaks or missing portions of
the color and black boxes.

To clean the ink cartridges automatically

a. Load letter or A4 unused plain white paper into the input tray.

b. Depending on your operating system, do one of the following to open the printer software:

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps
on the app bar, and then click the icon with the printer's name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start,
select All Programs, click HP, click HP Deskjet 2540 series, and then click HP Deskjet
2540 series.

c. In the printer software, click Print & Scan and then click Maintain Your Printer to access the
Printer Toolbox.

d. Click Clean Ink Cartridges on the Device Services tab. Follow the on-screen instructions.
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If the above solutions do not resolve the problem, click here for more online troubleshooting.
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Clear paper jam
Use the following steps to clear a paper jam.

Clear a paper jam from the input tray

1. Press the Cancel button to try to clear the jam automatically. If this does not work, the paper jam
will need to be cleared manually.

2. Pull the paper gently out of the input tray.

3. Press the Start Copy Black or Start Copy Color button on the control panel to continue the
current job.

Clear a paper jam from the output tray

1. Press the Cancel button to try to clear the jam automatically. If this does not work, the paper jam
will need to be cleared manually.

2. pull the paper gently out of the output tray.

3. Press the Start Copy Black or Start Copy Color button on the control panel to continue the
current job.

Clear a paper jam from the cartridge access area

1. Press the Cancel button to try to clear the jam automatically. If this does not work, the paper jam
will need to be cleared manually.
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2. Open the cartridge access door and slide the print carriage to the right to access the paper jam.

3. Press the Start Copy Black or Start Copy Color button on the control panel to continue the
current job.

Clear a paper jam inside of the printer

1. Press the Cancel button to try to clear the jam automatically. If this does not work, the paper jam
will need to be cleared manually.

2. Open the cleanout door located on the bottom of the printer. Press tabs on both sides of the
cleanout door.

3. Remove the jammed paper.
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4. Close the cleanout door. Gently push the door towards the printer until both latches snap into
place.

5. Press the Start Copy Black or Start Copy Color button on the control panel to continue the
current job.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Prevent paper jams

● Do not overfill the input tray.

● Remove printed papers from the output tray frequently.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Do not combine different paper types and paper sizes in the input tray; the entire stack of paper
in the input tray must be the same size and type.

● Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the
paper-width guide does not bend the paper in the input tray.

● Do not force paper too far forward in the input tray.

● Do not add paper while the printer is printing. If the printer is about to run out of paper, wait until
the out of paper message appears before adding paper.

If the above solutions do not resolve the problem, click here for more online troubleshooting.
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Unable to print
If you are having trouble printing, you can download the HP Print and Scan Doctor, which can
troubleshoot this issue for you automatically. To get the tool, click the appropriate link:

NOTE: The HP Print and Scan Doctor may not be available in all languages.

Take me to the HP Print and Scan Doctor download page.

Resolve print issues

Make sure that the printer is turned on and that there is paper in the input tray. If you are still unable
to print, try the following in order:

1. Check for error messages from the printer software and resolve them by following the on-screen
instructions.

2. If your computer is connected to the printer with a USB cable, disconnect and reconnect the
USB cable. If your computer is connected to the printer with a wireless connection, confirm that
the connection is working.

3. Verify that the printer is not paused or offline.

To verify that the printer is not paused or offline

a. Depending upon your operating system, do one of the following:

● Windows 8: Point to or tap the upper-right corner of the screen to open the Charms
bar, click the Settings icon, click or tap Control Panel, and then click or tap View
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click
Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click
Printers and Faxes.

b. Either double-click the icon for your printer or right-click the icon for your printer and select
See what's printing to open the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use
Printer Offline.

d. If you made any changes, try to print again.

4. Verify that the printer is set as the default printer.

To verify that the printer is set as the default printer

a. Depending upon your operating system, do one of the following:

● Windows 8: Point to or tap the upper-right corner of the screen to open the Charms
bar, click the Settings icon, click or tap Control Panel, and then click or tap View
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.
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● Windows Vista: From the Windows Start menu, click Control Panel, and then click
Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click
Printers and Faxes.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set
as Default Printer.

d. Try using your printer again.

5. Restart the print spooler.

To restart the print spooler

a. Depending upon your operating system, do one of the following:

Windows 8

i. Point to or tap the upper-right corner of the screen to open the Charms bar, and then
click the Settings icon.

ii. Click or tap Control Panel, and then click or tap System and Security.

iii. Click or tap Administrative Tools, and then double-click or double-tap Services.

iv. Right-click or touch and hold Print Spooler, and then click Properties.

v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click or tap Start, and then
click or tap OK.

Windows 7

i. From the Windows Start menu, click Control Panel, System and Security, and then
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click
OK.

Windows Vista

i. From the Windows Start menu, click Control Panel, System and Maintenance,
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler service, and then click Properties.
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iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click
OK.

Windows XP

i. From the Windows Start menu, right click My Computer.

ii. Click Manage, and then click Services and Applications.

iii. Double-click Services, and then select Print Spooler.

iv. Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set
as Default Printer.

d. Try using your printer again.

6. Restart the computer.

7. Clear the print queue.

To clear the print queue

a. Depending upon your operating system, do one of the following:

● Windows 8: Point to or tap the upper-right corner of the screen to open the Charms
bar, click the Settings icon, click or tap Control Panel, and then click or tap View
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click
Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click
Printers and Faxes.

b. Double-click the icon for your printer to open the print queue.

c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click
Yes to confirm.

d. If there are still documents in the queue, restart the computer and try printing again after
the computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again.

If the above solutions do not resolve the problem, click here for more online troubleshooting.
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Clear print carriage
Remove any objects, such as paper, which are blocking the print carriage.

See Clear paper jam on page 62 for more information.

NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when
removing jammed paper from inside the printer.

 Click here to go online for more information.

68 Chapter 8   Solve a problem ENWW

http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-924&h_client=s-h-e004-01&h_keyword=lp70007-all-DJ2540&h_lang=en&h_cc=us


Identify a defective cartridge
If both the tri-color and black ink cartridge lights are blinking, and the On button light is on, both
cartridges may still have tape on, be very low on ink, or are missing. First make sure that the pink
tape has been removed from both cartridges, and that both ink cartridges are installed. If both ink
cartridge lights are still blinking, then one or both cartridges may be defective. To determine if one
cartridge is defective, do the following:

1. Remove the black ink cartridge.

2. Close the cartridge access door.

3. If the On button light blinks quickly, replace the tri-color cartridge. If the On button light does not
blink, replace the black cartridge.
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Prepare trays
Open output tray

▲ Output tray must be open to begin printing.

Close cartridge access door

▲ Cartridge door must be closed to begin printing.

 Click here to go online for more information.
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Resolve copy and scan issues
HP provides an HP Print and Scan Doctor (Windows only) that can help solve many common “Unable
to scan” issues.

NOTE: The HP Print and Scan Doctor may not be available in all languages.

Take me to the HP Print and Scan Doctor download page.

Learn more about how to solve scan issues. Click here to go online for more information.

Learn how to solve copy issues. Click here to go online for more information.
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Printer failure
Resolve printer failure

▲ Turn the printer off, then on. If that does not resolve the problem, contact HP.

 Please contact HP support for help .
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Ink cartridge problem
First try removing and reinserting the ink cartridges. If this does not work, clean the cartridge
contacts. If your problem is still not resolved, replace the ink cartridges. For more information, see
Replace ink cartridges on page 41.

Clean the ink cartridge contacts

CAUTION: The cleaning procedure should take only a few minutes. Make sure that the ink
cartridges are reinstalled in the printer as soon as possible. It is not recommended to leave the ink
cartridges outside of the printer longer than 30 minutes. This could result in damage to the printhead
or the ink cartridges.

1. Check that power is on.

2. Open the cartridge access door and wait for the print carriage to move to the center of the
printer.

3. Remove the ink cartridge indicated in the error message.

4. Hold the ink cartridge by its sides with the bottom pointing up and locate the electrical contacts
on the ink cartridge.

The electrical contacts are the small gold-colored dots on the ink cartridge.

5. Wipe only the contacts with a dry swab or lint-free cloth.

CAUTION: Be careful to wipe only the contacts, and do not smear any of the ink or other
debris elsewhere on the ink cartridge.
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6. On the inside of the printer, locate the contacts for the cartridge.

The printer contacts are the set of gold-colored bumps positioned to meet the contacts on the ink
cartridge.

7. Use a dry swab or lint-free cloth to wipe the contacts.

8. Reinstall the ink cartridge.

9. Close the cartridge access door, and check if the error message has gone away.

10. If you still receive the error message, turn the printer off, and then on again.

NOTE: If one ink cartridge is causing problems, you can remove it and use the single-cartridge
mode to operate the HP Deskjet 2540 series with only one ink cartridge.

 Click here to go online for more information.
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Older generation cartridges
You will need to use a newer version of this cartridge. In most cases you can identify a newer version
of the cartridge by looking at the exterior of the cartridge package and finding the Warranty Ends
date.

If it says ‘v1’ several spaces to the right of the date, then the cartridge is the updated newer version. If
it is an older generation cartridge, contact HP support for help or replacement.

 Click here to go online for more information.

ENWW Older generation cartridges 75

http://h20180.www2.hp.com/apps/Nav?h_pagetype=s-924&h_client=s-h-e004-01&h_keyword=lp70036-all&h_lang=en&h_cc=us


Networking
● Learn how to find your network security settings. Click here to go online for more information.

● Learn about other troubleshooting tips. Click here to go online for more information.

● Learn about the HP Print and Scan Doctor. Click here to go online for more information.

● Learn how to change from a USB to wireless connection. Click here to go online for more
information.

● Learn how to work with your firewall and antivirus programs during printer setup. Click here to go
online for more information.
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HP support
● Register printer

● Support process

● HP support by phone

● Additional warranty options

Register printer
By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support,
and product support alerts. If you did not register your printer while installing the software, you can
register now at http://www.register.hp.com.

Support process

If you have a problem, follow these steps:

1. Check the documentation that came with the printer.

2. Visit the HP online support website at www.hp.com/support.

HP online support is available to all HP customers. It is the fastest source for up-to-date product
information and expert assistance, and includes the following features:

● Fast access to qualified online support specialists

● Software and driver updates for the printer

● Valuable troubleshooting information for common problems

● Proactive printer updates, support alerts, and HP newsgrams that are available when you
register the printer

3. Call HP support.

Support options and availability vary by printer, country/region, and language.

HP support by phone
Phone support options and availability vary by printer, country/region, and language.

This section contains the following topics:

● Phone support period

● Placing a call

● Support phone numbers

● After the phone support period
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Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America (including
Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to
www.hp.com/support. Standard phone company charges apply.

Placing a call
Call HP support while you are in front of the computer and the printer. Be prepared to provide the
following information:

● Product name (Located on the printer, such as Deskjet IA 2545)

● Product number (located inside the cartridge access door)

● Serial number (located on the back or bottom of the printer)

● Messages that appear when the situation occurs

● Answers to these questions:

◦ Has this situation happened before?

◦ Can you recreate it?

◦ Did you add any new hardware or software to your computer at about the time that this
situation began?

◦ Did anything else occur prior to this situation (such as a thunderstorm, the printer was
moved, etc.)?

Support phone numbers
For the most current HP list of telephone support numbers and call costs information, see
www.hp.com/support.

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may also be
available at the HP online support website: www.hp.com/support. Contact your HP dealer or call the
support phone number for your country/region to learn more about support options.

Additional warranty options
Extended service plans are available for the HP Deskjet 2540 series at additional costs. Go to
www.hp.com/support, select your country/region and language, then explore the services and
warranty area for information about the extended service plans.
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A Technical information

The technical specifications and international regulatory information for the HP Deskjet 2540 series
are provided in this section.

For additional specifications, see the printed documentation that came with the HP Deskjet
2540 series.

This section contains the following topics:

● Hewlett-Packard Company notices

● Specifications

● Environmental product stewardship program

● Regulatory notices
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Hewlett-Packard Company notices
The information contained herein is subject to change without notice.

All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior
written permission of Hewlett-Packard, except as allowed under the copyright laws. The only
warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained
herein.

© 2012 Hewlett-Packard Development Company, L.P.

Microsoft®, Windows ®, Windows® XP, Windows Vista®, Windows® 7 and Windows® 8 are U.S.
registered trademarks of Microsoft Corporation.

80 Appendix A   Technical information ENWW



Specifications
Technical specifications for the HP Deskjet 2540 series are provided in this section. For more product
specifications, see the Product Data Sheet at www.hp.com/support.

● System requirements

● Environmental specifications

● Input tray capacity

● Output tray capacity

● Paper size

● Paper weights

● Print specifications

● Copy specifications

● Scan specifications

● Print resolution

● Power specifications

● Cartridge yield

● Acoustic information

System requirements
Software and system requirements are located in the Readme file.

For information about future operating system releases and support, visit the HP online support
website at www.hp.com/support.

Environmental specifications
● Recommended operating temperature range: 15 ºC to 32 ºC (59 ºF to 90 ºF)

● Allowable operating temperature range: 5 ºC to 40 ºC (41 ºF to 104 ºF)

● Humidity: 15% to 80% RH non-condensing; 28 ºC maximum dewpoint

● Nonoperating (Storage) temperature range: –40 ºC to 60 ºC (–40 ºF to 140 ºF)

● In the presence of high electromagnetic fields, it is possible the output from the HP Deskjet
2540 series may be slightly distorted

● HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize
injected noise due to potential high electromagnetic fields

Input tray capacity
Plain paper sheets (80 g/m2 [20lb]): Up to 50

Envelopes: Up to 5
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Index cards: Up to 20

Photo paper sheets: Up to 20

Output tray capacity
Plain paper sheets (80 g/m2 [20lb]): Up to 30

Envelopes: Up to 5

Index cards: Up to 10

Photo paper sheets: Up to 10

Paper size
For a complete list of supported media sizes, see the printer software.

Paper weights
Plain Paper: 64 to 90 g/m² (16 to 24 lb)

Envelopes: 75 to 90 g/m² (20 to 24 lb)

Cards: Up to 200 g/m² (110-lb index maximum)

Photo Paper: Up to 280 g/m² (75 lb)

Print specifications
● Print speeds vary according to the complexity of the document

● Method: drop-on-demand thermal inkjet

● Language: PCL3 GUI

Copy specifications
● Digital image processing

● Copy speeds vary according to the complexity of the document and model

Scan specifications
● Resolution: up to 1200 x 1200 ppi optical

For more information about ppi resolution, see the scanner software.

● Color: 24-bit color, 8-bit grayscale (256 levels of gray)

● Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)
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Print resolution

Draft mode

● Color Input/Black Render: 300x300dpi

● Output (Black/Color): Automatic

Normal mode

● Color Input/Black Render: 600x300dpi

● Output (Black/Color): Automatic

Plain-Best mode

● Color Input/Black Render: 600x600dpi

● Output (Black/Color): Automatic

Photo-Best mode

● Color Input/Black Render: 600x600dpi

● Output (Black/Color): Automatic

Max DPI mode

● Color Input/Black Render: 1200x1200dpi

● Output: Automatic (Black), 4800x1200 optimized dpi (Color)

Power specifications

0957-2385

● Input voltage: 100-240Vac (+/- 10%)

● Input frequency: 50/60 Hz (+/- 3Hz)

0957-2403

● Input voltage: 200-240Vac (+/- 10%)

● Input frequency: 50/60 Hz (+/- 3Hz)

NOTE: Use only with the power adapter supplied by HP.

Cartridge yield
Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Acoustic information
If you have Internet access, you can get acoustic information from the HP website. Go to:
www.hp.com/support.
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Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner.
Design for recycling has been incorporated into this product. The number of materials has been kept
to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been
designed to separate easily. Fasteners and other connections are easy to locate, access, and remove
using common tools. High priority parts have been designed to access quickly for efficient
disassembly and repair.

For more information, visit HP's Commitment to the Environment Web site at:

www.hp.com/hpinfo/globalcitizenship/environment

● Eco-Tips

● Paper use

● Plastics

● Material safety data sheets

● Recycling program

● HP inkjet supplies recycling program

● Power consumption

● Sleep mode

● Disposal of waste equipment by users

● Chemical substances

● Toxic and hazardous substance table (China)

● Restriction of hazardous substance (Ukraine)

● Restriction of hazardous substance (India)

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. Please visit the HP
Environmental Programs and Initiatives website for more information on HP’s environmental
initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of product life.
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Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions,
and partners with some of the largest electronic recycling centers throughout the world. HP conserves
resources by reselling some of its most popular products. For more information regarding recycling of
HP products, please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free
of charge. For more information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified
to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment.
The following mark will appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/
energystar

Sleep mode
● Power usage is reduced while in Sleep mode.

● After initial setup of printer, the printer will enter Sleep mode after 5 minutes of inactivity.

To change the time to Sleep mode:

1. Open the EWS. For more information, see To open the embedded web server on page 55.

2. Click the Settings tab.

3. In the Power Management section, click Energy Save Mode, and select the desired option.

4. Click Apply.
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Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste.
Instead, you should protect human health and the environment by handing over your
waste equipment to a designated collection point for the recycling of waste electrical
and electronic equipment. For more information, please contact your household waste
disposal service, or go to http://www.hp.com/recycle.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach.

Toxic and hazardous substance table (China)

Restriction of hazardous substance (Ukraine)
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Restriction of hazardous substance (India)
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Regulatory notices
The HP Deskjet 2540 series meets product requirements from regulatory agencies in your country/
region.

This section contains the following topics:

● Regulatory model identification number

● FCC statement

● Notice to users in Korea

● VCCI (Class B) compliance statement for users in Japan

● Notice to users in Japan about the power cord

● European Union Regulatory Notice

● Declaration of conformity

● Regulatory wireless statements

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is SNPRB-1204-02. This regulatory number should not be
confused with the marketing name (HP Deskjet 2540 All-in-One series, HP Deskjet Ink Advantage
2545 All-in-One series, etc.) or product numbers (A9U22A to A9U28A, etc.).

88 Appendix A   Technical information ENWW



FCC statement

Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord
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European Union Regulatory Notice
Products bearing the CE marking comply with the following EU Directives:

● Low Voltage Directive 2006/95/EC

● EMC Directive 2004/108/EC

● Ecodesign Directive 2009/125/EC, where applicable

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter
provided by HP.

If this product has telecommunications functionality, it also complies with the essential requirements
of the following EU Directive:

● R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European standards
(European Norms) that are listed in the EU Declaration of Conformity issued by HP for this product or
product family and available (in English only) either within the product documentation or at the
following website: www.hp.com/go/certificates (type the product number in the search field).

The compliance is indicated by one of the following conformity markings placed on the product:

For non-telecommunications products and for EU harmonized
telecommunications products, such as Bluetooth® within power class below
10mW.

For EU non-harmonized telecommunications products (If applicable, a 4-digit
notified body number is inserted between CE and !).

Please refer to the regulatory label provided on the product.

The telecommunications functionality of this product may be used in the following EU and EFTA
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France,
Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg,
Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, and United Kingdom.

The telephone connector (not available for all products) is intended for connection to analogue
telephone networks.
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Products with wireless LAN devices

● Some countries may have specific obligations or special requirements about the operation of
Wireless LAN networks such as indoor use only or restrictions of the channels available. Please
make sure that the country settings of the wireless network are correct.

France

● For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may
be used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For
outdoor use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used.
For the latest requirements, see www.arcep.fr.

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen,
GERMANY
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Declaration of conformity

Regulatory wireless statements
This section contains the following regulatory information pertaining to wireless products:

● Exposure to radio frequency radiation

● Notice to users in Brazil

● Notice to users in Canada

● Notice to users in Mexico

● Notice to users in Taiwan
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● Wireless notice to users in Japan

Exposure to radio frequency radiation

Notice to users in Brazil
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Notice to users in Canada

Notice to users in Mexico
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Notice to users in Taiwan

Wireless notice to users in Japan
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